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INTRODUCTION 

 

When I had my photovoltaic solar panels installed, I received the usual recommendations from the 

installer "If you are used to running your appliances at night when the rates are cheaper, you need to 

run your appliances during the day and take advantage of free electricity".  That seemed rather 

obvious, but we have to remember that installers are supposed to be experts in installing solar panels, 

and not necessarily experts on using them. 

 

As time passed, I noticed that there are many moments during the day when my panels were producing 

a lot of watts, and not so much at other times (passing clouds, rain …).  I saw that my appliances were 

running (dish washer, washing machine, hot water heater) when my panels were not producing enough 

watts (I was therefore drawing electricity from the grid), and then an hour later bright sunshine would 

be available for many hours. I wondered, "It would be wonderful if I had a way to allow my appliances 

to run only when there was enough solar power for it to be free". 

I searched for a piece of software that would allow just that, but I didn't find any. There are a few 

rudimentary services out there, which do make it possible to control only a few appliances, but these 

services are linked to the Internet, and these systems, remotely, "decide" to turn your hot water tank 

on or off based solely on the weather forecast for the day for your postcode! So these systems do not 

allow for precise control, and in any case they do not work if you are cut off from the Internet. 

Since I could not find any software, and as I am a home automation enthusiast and know how to write 

computer programs, I decided to create the software myself. And that's how SWOpti came about. 

Here is a more concrete example to illustrate just to what extent it is possible to save money.  I have a 

200-litre hot water tank.  If no more hot water is available in the morning because several people have 

taken a shower (I have a large family!) it could take 3 hours for the tank to fully heat up again.  When 

operating, the appliance consumes 2,500 watts.  At the time I'm writing this, the basic electricity rate 

in France is 0.20 € per kWh. A kilowatt-hour represents the use of a vacuum cleaner (which consumes 

1000 watts) for one hour.  So using your vacuum cleaner for one hour costs 0.20 €.  With the hot water 

heater, 2,500 watts multiplied by 0.20 € therefore equals 0.50 € for one hour of heating.  Let's suppose 

that your hot water tank turns on at 10 a.m., but between 10 a.m. and 11 a.m. your solar panels are 

not producing enough watts to operate your tank; you will then have to pay your electricity provider 

0.50 €.  But between 11 a.m. and 1 p.m. (and for most of the rest of the day!) there's a lot of sunshine, 

so you don't have to pay anything for those two hours of heating.  If this scenario were to repeat itself 

day after day, in a month you will have paid 0.50 € x 30 days = 15 euros needlessly to your electricity 

provider, and that represents 180 euros a year!  If "unfortunately" your contract grants you a cheaper 
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rate at night and a higher rate during the day, you'll be heating your water during the day at the high 

rate at 0.22 € / kWh which will cost 0.55 € a day, 16.50 euros a month, or 198 euros for the year.  And 

if you really aren't the lucky type, because your tank used solar energy for only one hour and the other 

two hours your electricity provider supplied you from the grid, that would cost 1.10 euros a day, 33 

euros a month, or 396 euros a year.  And all that is just an example for a single appliance: you can 

imagine the savings that are possible if all your appliances that consume a lot of power were controlled 

to operate only when the electricity was free. 

 

And SWOpti does even more: if SWOpti sees that you are drawing power from the grid, it will try to 

turn off appliances (= immediate savings) while waiting for free electricity to become available again to 

turn appliances back on. 
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OPERATING PRINCIPLE 

 

SWOpti works with sensors that are literally placed around wires in your electrical cabinet. This means 

that the system is non-invasive; simply find the right wires and position the sensors around the wires.  

Every 5 seconds, these sensors measure: 

➢ the total watts that your panels (or wind turbines) are producing (above the pictogram) 

➢ the production details among your installed panels, wind turbines and Plus-and-Play panels 

➢ the watts that your home is currently consuming 

➢ the watts that are coming from the panels 

➢ the watts that the panels are exporting to the grid 

➢ the watts that your energy supplier is sending to you. 

The watts that the panels are sending to your battery and the watts that the battery is sending to your 

home are also measured, if your installation has a battery.  The screenshot below is from SWOpti's main 

control screen and allows you to monitor all these figures in real time. 

 

 

 

Before the installation of SWOpti, you compiled a list of the appliances to control/monitor, and you 

gave a priority to your appliances; in my home for example, the electric car charger has priority, 

followed by the two hot water tanks (I mentioned that I have a big family, but also a big house), then 

the household appliances and finally the electric radiators. And for each appliance, SWOpti has to know 

the number of watts that the appliance needs to operate.  Each appliance has a small module that 

SWOpti uses to turn it on and off. Once all of this is in place, SWOpti takes care of everything. The 
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possibilities are explained in the two paragraphs below, where examples in watts are provided in 

parentheses. 

 

We've got juice       

Once a minute, SWOpti takes a look at the number of watts the panels are producing (7000), and how 

many watts your home is consuming (2000).  If there is excess production (5000), SWOpti starts at the 

top of the list of your appliances, and analyses the question "what appliances can I turn on with my 

5000 watts available?" According to the number of watts available, and according to the order of 

priority of the appliances and how many watts are needed for each appliance, SWOpti will turn on what 

it can.  Sometimes an appliance on the list is already turned on. You must also consider that the order 

of priority is relative, in that if you have 2800 watts available, although the electric car charger has the 

highest priority, it will not be turned on because it needs 3000 watts. Even though the hot water tank 

has a lower priority, it will be turned on because it only needs 2500 watts. Perhaps a little later there 

will be more sun, therefore enough to turn on the car charger, or at some given time the hot water 

tank will stop consuming power because the water is hot and therefore these watts will "return" to the 

system and SWOpti will be able to "assign" them to the car charger. 

 

We don't have enough juice      

Unfortunately, there will be moments when solar panel production will not be able to meet the needs 

of your home, and you will therefore be forced to draw power from the grid. SWOpti will try to reduce 

this as much as possible, by doing the opposite of what it did when there was excess power: SWOpti 

will note how many watts your home is drawing from the grid and will start at the bottom of your list 

of appliances, therefore with the appliances that have the lowest priority, so as to turn them off. In my 

home, these are the electric radiators, and among these radiators, the one in the hall has the lowest 

priority. This will make it possible to reduce power consumption from the grid, and even eliminate it. 

Example: You are producing 5500 watts and your home is consuming 4900 watts, and in these 4900 

watts we have a hot water tank that is consuming 2000 watts.  Your two daughters, simultaneously, 

each turn on a hairdryer that consumes 1250 watts (therefore 2500 watts more). The 4900 watts that 

you were already consuming, plus the 2500 watts = 7400 watts. With your production of 5500 watts, 

you are missing 1900 watts. These 1900 watts will have to be drawn from the grid. SWOpti will detect 

this consumption and will turn off an appliance, probably the hot water tank, thus reducing your 

consumption to 5400 watts (and therefore you will no longer need power from the grid).  If the other 

items have not changed (your production, consumption elsewhere in your home, etc.), SWOpti will 

turn the hot water tank back on when the hairdryers have been turned off. 
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Wait a minute, that means an appliance with low priority could perhaps never be turned on?  

To overcome this problem, SWOpti is configured with a "delta" temperature system and a "catch-up" 

time that can be configured for each radiator. First you decide the desired temperature (the 

temperature setting), which can be adjusted to the nearest half-hour, and day by day, for each room. 

The delta temperature is set to 3°C, but you can change it. The catch-up time is set to 45 minutes and 

it too can also be changed. If you have set a temperature of 19° in a room and the temperature falls to 

18°, SWOpti will turn on the radiator in question. But shortly afterwards, SWOpti could turn off the 

radiator in order to avoid drawing power from the grid.  If ever the temperature drops to lower than 

the delta temperature, here 19° - 3° = 16°, SWOpti will turn on the radiator by programming an 

Immediate Timed Override On for 45 minutes (the default "catch up" time).  
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SYSTEM COMPONENTS 

 

 

 

1) SWOpti Box. This is a low-power mini PC (provided by SWOpti).  For maximum performance, 

your SWOpti Box must be used only for SWOpti, and so that SWOpti can do its job, it must be 

on permanently. 

2) HomeSeer. This is the home automation software that SWOpti "runs on".  

3) The SWOpti software itself 

4) A Zigbee controller*. This is often connected via a USB port. The controller sends the On/off 

commands to the appliances, and the controller receives management information from the 

latter (in particular, the quantity of watts that the appliances are consuming) 

5) A Zigbee module* for each appliance that you want to control or monitor.  These modules are 

generally of three types, according to the appliance to control/monitor. 

 

* The Zigbee communication protocol was chosen for SWOpti because it works with simple radio waves 

which are not harmful to humans.  The controller does not simply send the on/off orders to the 

modules; the modules also "respond" to the controller, confirming that they have indeed received the 

orders, and indicate the watts currently consumed, etc. Communication is therefore not in one 

direction; it is bidirectional. This increases the safety and reliability of the communications. 
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The Zigbee PROTOCOL IN SWOpti COMMUNICATIONS 

 

Each appliance that you wish to control/monitor has to have a Zigbee module.  From its Zigbee 

controller, SWOpti sends a command to the Zigbee module telling it to cut off the power or to turn it 

back on. Indeed, there is an absolute condition for this to work correctly: the appliance to be controlled 

must be able to resume operating all by itself when the power comes back on after a power cutoff.  

Concretely, this means that when the power goes out during thunderstorm for example, your lights, 

hot water tank, etc. will of course stop operating.  When the power comes back on, the hot water tank 

and the lights that were on when the power went off will now continue to operate, without any human 

intervention.  I have a dishwasher and a washing machine that, when power returns after a cutoff, 

resume operating by themselves and continue their cycles, as if there had not been any loss of power.  

It is this type of appliance that SWOpti can control.  Unfortunately, this is not the case for my clothes 

dryer.  When the power comes back on, the dryer does not resume operating by itself. Someone has 

to push the "Start" button in order for it to continue its work.  SWOpti cannot control this type of 

appliance. 

That said, if SWOpti cannot control a device such as my dryer, it can at least monitor it.  That means 

that you can see the quantity of watts that the appliance in question is drawing from your installation.  

This is useful for appliances that cannot be controlled (such as my dryer) and also for appliances that 

you do not want to control, such as an oven.  You wouldn't want SWOpti to decide to cut off the power 

to your oven simply because there isn't enough power to run it without having recourse to the grid. 

This appliance will therefore be seen by SWOpti as a "monitoring only" appliance. 

Note that an appliance that does not work after a power cutoff can even so be controlled by SWOpti if 

it has a "dry contact". 

The Zigbee modules to be installed for each appliance are generally of three types, according to the 

device to be controlled/monitored: 

➢ The first is a module that is installed behind an electric radiator (if the radiator is not plugged 

directly into a wall socket. There is a simple version of the module as well as a version that has 

a pilot wire. 

➢ The second type of module is intended to control a hot water tank or an electric vehicle charger. 

It can be installed where your cables arrive at the hot water tank, or in your electrical cabinet, 

starting from the circuit breaker of the appliance in question. 

➢ The third type of module is reserved for any type of appliance that you plug into the wall socket 

(such as most washing machines, dishwashers, a fan that heats or cools, etc.). The module is 

plugged into the wall socket and the plug of the device is plugged into the module. 

SWOpti sends the commands to turn an appliance on/off to the Zigbee controller, and it is the controller 

that in the end sends the command to the appliance to be controlled.  Ideally, the Zigbee controller 

should be installed in your home at a location where it can communicate with all the Zigbee modules. 

This means, in general, in the centre of your home, with respect to where your appliances are located.  

There are two types of Zigbee controllers. The first looks like a USB key and is plugged directly into the 

SWOpti Box.  This means that as the controller should be in the middle of your installation, the SWOpti 

Box too.  Another solution is to use a "Z-Net" controller. A Z-Net can be placed anywhere in your home; 

it will connect to SWOpti via the Wifi network or, better yet, your Ethernet (wired) network.  Another 

good thing to note is that Zigbee modules know how to operate as "relays" for the other modules. This 

means that your controller can be installed in a room, your hot water tank in the next room and your 
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washing machine even further away.  The controller sends a command intended for your washing 

machine, but the module in the hot water tank will take it and will "forward" the command, to the 

washing machine. And finally, there are specialised Zigbee modules that do nothing but take the Zigbee 

signal (which may already be at the maximum distance from the controller), amplify it and send it 

further on, like those "Wifi extenders" that can expand your Wifi network. 
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A LITTLE VOCABULARY … 

 

SWOpti has a main control screen that itself gives access to other screens.  You can manage SWOpti 

from a PC, tablet or mobile phone, as long as the device has an internet browser.  Before taking a more 

detailed look at the main screen, let's get familiar with the terms that one encounters when using 

SWOpti. 

 

MODES 

 

NORMAL. This is the default mode for an appliance. In Normal mode, SWOpti analyses the 

watts available and decides to turn appliances on or off, based on the number of watts the 

appliance uses and where it falls on the priority list. The symbol is green, representing the ability to 

save money in this mode. The two arrows form a circle symbolising the switching between "on" and 

"off", according to the watts available. 

 

OVERRIDE OFF. For one reason or another, you may want a device to stay off until you decide 

otherwise. The Override Off mode is used for this. For example, you have given a higher priority 

to your vehicle charger than to your hot water tank.  But, exceptionally, you want to give priority to the 

hot water tank. You can put the charger in Override Off, which would give SWOpti the possibility to 

allocate the available watts to the hot water tank. An appliance in Override Off mode will remain off 

until you select another mode. The black colour indicates an absence of power; the appliance is 

therefore turned off. 

 

IMMEDIATE TIMED OVERRIDE OFF. The Immediate Timed Override Off mode is similar to the 

Override Off mode. The difference is that you indicate the number of minutes that the device 

is to remain off. When the minutes have elapsed, the appliance returns to Normal mode.  The black 

colour indicates the appliance is off, and the small stopwatch reminds you that this is a timed override 

off. 

 

 DEFERRED TIMED OVERRIDE OFF. The Deferred Timed Override Off mode is very close to 

Immediate Timed Override Off. The difference is that you indicate at what time of the day or 

night you want the timed override off to begin. This is useful for programming an appliance to be off 

starting at 5am for one hour for example. The icon is black to indicate an Override Off, the stopwatch 

reminds you that this is a timed override off, and the clock indicates that the override off starts at a 
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precise time. Deferred Timed Override Off mode can be activated or deactivated per day of the week 

(the days in capital letters in the day bar are the days when this mode is active, and the mode is 

deactivated for the days that are displayed in small letters). Click on the day of the week to switch 

between activated/deactivated. 

 

MONITORING ONLY. This is the mode for appliances that you cannot control (such as a dryer 

that does not continue operating by itself after a power cutoff) or that you do not want to 

control (such as an oven). The magnifying glass indicates that this appliance is monitored only and that 

it cannot be controlled. 

 

OVERRIDE ON. This is the opposite of Override Off.  Override On mode is used to force an 

appliance to remain on. Imagine a few friends call you in the afternoon to tell you they are 

coming to your home to party and that they will probably be staying the night.  You can put your hot 

water tank into Override On mode to make sure that there is enough hot water this evening. An 

appliance in Override On mode will remain on until you select another mode. 

 

IMMEDIATE TIMED OVERRIDE ON. Immediate Timed Override On mode is similar to 

Override On. The difference is that you indicate the number of minutes that the device is 

to remain on. When the minutes have elapsed, the appliance returns to Normal mode.  The 

yellow colour indicates that the appliance is on, and the small stopwatch reminds you that this is a 

timed override on. 

 

 DEFERRED TIMED OVERRIDE ON. Deferred Timed Override On mode is very close to 

Immediate Timed Override On. The difference is that you indicate at what time of the day or 

night you want the timed override on to begin. This is useful for example to programme your 

hot water tank to turn on at 5am for one hour. The icon is yellow to indicate an Override On, the 

stopwatch indicates that this is a timed operation, and the clock reminds you that the override on starts 

at a precise time. Deferred Timed Override On mode can be activated or deactivated per day of the 

week (the days in capital letters in the day bar are the days when this mode is active, and the mode is 

deactivated for the days that are displayed in small letters). Click on the day of the week to switch 

between activated/deactivated. 
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GUARANTEED OPERATING TIME. The Guaranteed Operating Time mode is useful to set the 

number of hours or minutes that an appliance must operate per day. Example: a pool filter 

pump that must operate five hours a day, but not necessarily five hours non-stop. SWOpti will turn on 

the pump only when you have enough electricity to operate it free of charge. This mode can be 

activated/deactivated independently for each day of the week. 

 

This icon indicates that the Guaranteed Operating Time mode is activated. 

 

 

 REVERSE OVERRIDE END. When you have programmed a Timed Override On or a Timed 

Override Off, SWOpti systematically returns to Normal mode when the minutes have elapsed. 

This means that after the Timed Override On or Timed Override Off, it is the presence or absence of 

available watts that will determine whether the appliance is turned on or off.  However, at the end of 

a Timed Override On, you may want the appliance to be turned off or, at the end of a Timed Override 

Off, you may want the appliance to be tuned on.  The Reverse Override End allows for this. 

 

 NORMAL OVERRIDE END. Contrary to Reverse Override End, the appliance, when it comes 

out of a Timed Override On, will remain on. If the appliance is coming out of a Timed Override 

Off, it will remain off. 

 

 

 SACRIFICABLE APPLIANCE. This appliance will be turned off (sacrificed) if the watts it 

consumes plus the available production would allow a privileged appliance to be turned on. 

See details in the "Privileged/Sacrificable Appliances" chapter. 

 

 PRIVILEGED APPLIANCE. This appliance will be turned on if a sacrificable appliance has just 

been turned off because the watts it consumes plus the available production would allow the 

privileged appliance to be turned on. See details in the " Privileged/Sacrificable Appliances " 

chapter. 

 

NORMAL APPLIANCE. The selected appliance is not a designated sacrificable or privileged 

appliance. See details in the " Privileged/Sacrificable Appliances " chapter. 
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HEATING ON. When this Heating icon is displayed, SWOpti will turn your electric radiators on 

or off according to the temperature settings in effect for each room.  In other words, SWOpti is 

managing the heating. 

 

HEATING OFF. When this Heating icon is displayed (with an "X" on the flame), SWOpti is not 

managing the heating.  All the radiators are put into Override Off mode.  This is normally the 

case in the summer and, for example, if you go on holiday in the winter and you do not want to heat 

your home while you are away. 

 

  CONFIGURATION SCREEN. Click on this icon to go to the Configuration screen. 

 

 

TEMPERATURE SETTINGS. This icon takes you to the screen where you can modify the 

temperature settings for the appliances in question.  These temperature settings can be 

applied for appliances that heat (an electric radiator in general) or for appliances that cool (a fan …). 

You can also modify the delta temperature and the "catch-up" time (see the section on "SWOpti and 

heating "). 

  



 

 15 

APPLIANCE TYPES 

 

SWOpti manages 5 types, or categories, of appliances: 

 

➢ Appliances that heat the home. A minimum temperature must be maintained. These are primarily 

electric radiators, an electric fan that heats or a heat pump. 

 

➢ Appliances that cool the home. A maximum temperature must not be exceeded. These are fans 

that move the air to lower the temperature or air conditioning systems. 

 

➢ Any other appliance that is not part of the first two categories and that can be controlled to be 

turned on/off according to the availability of watts: washing machine, dishwasher, electric vehicle 

charger, hot water tank, clothes dryer … 

 

➢ Appliances that cannot be controlled (because they do not continue working on their own after a 

power cutoff) or that you do not want to control (such as an oven).  These are referred to as 

"monitoring only" appliances. 

 

➢ The MNR category (Mini Night Reserve).  More details on this special category are provided in the 

"Storage" section of this manual. 
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STORAGE, AND THE CREATION OF MNR 

 

As the sun doesn't shine at night, you can use batteries to store energy during the day in order to use 

it at night.  The idea is to be able to meet the "background" needs in electricity of your home as much 

as possible. The "background" is the quantity of electricity that your house uses when "nothing is 

turned on". "Nothing turned on" really means that no "major appliance" is turned on.  Excluding 

electric radiators if you have them, the background electricity is the refrigerator, freezer, radio alarm 

clock, internet box, SWOpti box, mobile telephone chargers … You could say it is the electricity used by 

your house when you are not even home or when you are sleeping at night. 

 

A battery directly linked to your photovoltaic panels will allow you to store your surplus production so 

as to use it at night or when there isn't a lot of sunshine, but these batteries are still quite expensive.  

There is an intermediate solution to store electricity for use at night and reduce the dependency on 

your electricity provider. This solution has been optimised so that SWOpti can draw a maximum 

number of benefits from it. This entails using a so-called "backup" or UPS (Uninterruptible Power 

Supply) battery. This is the type of battery that, when a power outage occurs, will allow you to save 

your work on your computer and shut down the computer "correctly". The time that you have to turn 

off these appliances powered by the battery depends on the power consumed by these appliances and 

the capacity of the battery (and to what extent the battery is charged when the power outage occurs).  

Instead of spending thousands of euros for "official" solar batteries, you can use a "backup" battery 

that could cost less than 100 euros, but you should plan on spending a few hundred euros. Once again, 

that depends on the power of the appliances that you want to connect to the battery. 

 

Here are two examples.  In the parents' bedroom, you have two bedside lamps (10 watts each), two 

telephone chargers (15 watts each), a radio alarm clock with projection of the time on the ceiling (15 

watts), a "bug zapper" with a soft blue light (15 watts). Although the bedside lamps and the telephone 

chargers will not be constantly in use all night long, let's suppose that they are.  That makes a total of 

80 watts.  If we simplify things by saying that from 9pm to 9am is the period after sunset and before 

sunrise, that is 12 hours. 80 watts x 12h = 960 watts (therefore 0.20 euros, before the increase in rates 

scheduled for 2024). If you have no means of storing the electricity produced free of charge during the 

day, it is certain that every little watt you use at night will have to be paid for. In this example, this would 

amount to 73 euros a year.  If you use a MNR with SWOpti, you can find a 1000 watt battery for about 

100 euros. It would then take a little more than one year to recoup the investment. 
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The second example is a response to a question that I am frequently asked: "To save electricity, can I 

safely turn off my freezer a few hours a night or even the entire night?"  A quick search on the Internet 

provides a response to these two questions. From a sanitary standpoint, the answer is Yes… a freezer 

can in general remain without electricity for 24h, as long as you do not open the door! From an 

electricity savings standpoint, the answer is not as clear.  It is obvious that you will save electricity when 

the appliance is off, but the freezer will use as much electricity (and even more) to return to the state 

that it was in before the power was cut off than if there was no power cutoff at all.  But this answer is 

to be nuanced according to whether or not you have solar panels. A person without solar panels would 

certainly lose money, as they would spend more given that the freezer consumes more during the day 

to offset what was saved at night. But, if you have solar panels, this isn't a problem because this "extra" 

electricity to "catch up" is free. Also keep in mind that this system would not work from a sanitary 

standpoint if you put a lot of food into the freezer just before the programmed power cutoff occurs. 

 

To overcome this sanitary problem … use a MNR with SWOpti!  The operating cycle of my freezer is 100 

watts for 20 minutes, then 2 or 3 watts for 40 minutes.  If we ignore the few watts consumed for 40 

minutes, this means that in reality, the freezer consumes 100 watts in three hours (because it is 

consuming 100 watts only a third of each hour).  If we retain the same scenario of a power cutoff for 

12 hours (that is 4 periods of 3 hours at 100 watts per period of 3 hours), you would need a battery 

that could supply 400 watts. Without a battery at all, you would pay 0.08 euros every night. That isn't 

much, but that does represent almost 30 euros a year, and it doesn't include the 2 or 3 watts per period 

of 40 minutes that we have excluded. 

 

When you have an MNR, SWOpti "turns on" the battery at sunrise. This makes it possible to supply the 

load (here, the freezer) and also charge the MNR free of charge with the sun. At sunset, SWOpti "turns 

off" the power supply to the battery, which is interpreted by the battery as if there has been a power 

outage. The freezer will therefore be powered by the free electricity stored in the battery. No sanitary 

problem because the freezer in the end is always powered. 

 

There is also another non-negligible advantage.  We are not using the MNR as a "backup" battery 

because we are actually using it by force every night.  But if there were a genuine power outage, the 

MNR would take over and continue powering the appliances connected to it. 

 

If needed, you can program an Override On for an MNR. This means that when the sun sets, SWOpti 

will not deprive the battery of power; power from the house will continue to supply the battery and 

therefore the appliances connected to it. 
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THE MAIN CONTROL SCREEN 

 

Here is an example of the main control screen: 

 

 

 

First of all, note that if you hover your mouse pointer on certain elements of the screen, a small info 

bubble will pop up to provide you with information on this part of the screen (if your browser is 

compatible with this feature). 

 

The upper lefthand corner shows the status of your installation. You'll find the date and time, and the 

version of SWOpti that you have. The figures for the watts are in real time and are updated every 5 

seconds. Your total production is displayed above the solar panel pictogram, and below this pictogram, 

you have the details for each production system: PV1 for your first array of solar panels, WT for wind 

turbines and PP for Plug-and-Play (PnP) panels. If you have PnP panels and SWOpti has cut off some of 

these PnP panels because you have exceeded the injection limit, this will be indicated as PP1 = X".  

Above the pictogram of the house, you have the number of ways sent to the house for consumption, 

and below this pictogram, the total consumption of the house. Above the electric pylon, you have the 

number of watts sent to the network (green arrow), and below, the number of watts you are consuming 

coming from the network (red arrow). Above the battery, you have the number of watts sent to the 

battery for storage, and below, the number of watts that you are taking from the battery for 

consumption by the house. If your battery can be "queried", you will see, just below the battery, the 

percentage of charge and the number of watts that this represents. 

 

If you have a three-phase installation, for each measurement of watts, the detail per phase can 

displayed. To obtain this display, tapez "JJFWPSettings£TPMode£T" without the inverted commas in 
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the zone normally reserved for changing the name of an appliance, and click on "ABS --> XYZ". To return 

to the dimple total displya, type "JJFWPSettings£TPMode£M". 

 

The portion of the screen on the righthand side provides information of the current status of each of 

the appliances that are controlled/monitored.  They are listed by order of priority. For each appliance, 

we have its name displayed on the button, on the left an icon indicating whether the appliance is 

currently on (yellow) or off (black), and on the right an icon that indicates the mode of the appliance. 

Under the button, on the left, we have the watts that the appliance is currently consuming and on the 

right, the number of minutes remaining with a "+" (if a Timed Override On or Guaranteed Operating 

Time is in progress) or a "-" (if a Timed Override Off is in progress).  If you have a three-phase installation, 

centred between these two figures, you will find a letter (A, B or C) indicating on which phase this 

appliance is operating. 

 

Let's take a closer look at the icon on the left, which indicates whether the appliance is on or off. It 

must be made clear that in SWOpti terms, "on" means that SWOpti is authorising the appliance to 

consume watts. That does not mean that the appliance is consuming watts. For example, the hot water 

tank may be on (it is receiving power) but it is consuming 0 watts because the water is hot. Appliances 

in "Monitoring Only" mode, indicated by the magnifying glass icon on the right, are always turned on, 

as SWOpti does not control them. 

 

In the middle of the lefthand side of the screen, on a grey background, you have on the left the 

maximum number of watts that your panels have produced since midnight up until now and the time 

that took place, and on the right the maximum number of watts that you have drawn from the grid 

since midnight up until now. In the middle, you will find an indication with the date and time of the 

latest action that SWOpti has performed. 

 

On a yellow background, you will find information about the sun: the time of sunrise, solar noon (the 

time of day when the sun is at its culmination point) and the time of sunset. 

 

The screen section with a light green background indicates which appliance is currently selected for 

customised control, and just below are the buttons that you can use to control the selected appliance. 

 

The icons on the last line of the screen will be explained further on in this document.  
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HOW TO CONTROL AN APPLIANCE WITH THE CONTROL SCREEN 

 

Normally, SWOpti is entirely automatic and will turn on/off your appliances according to the electricity 

available. But you can also control the appliances yourself by using this control screen. 

In the righthand part of the screen, press the button with the name of the appliance that you want to 

control. In a few seconds, in the lefthand part of the screen, you will see the name of the appliance 

that you have just selected. Under the name, the icon on the left which indicates whether the appliance 

is on/off and the icon on the right which indicates the current mode will be updated. These icons are 

simply indicators that reflect the same icons on the righthand part of the screen for the appliance. 

 

Under the days of the week, press the icon to launch an Override Off. The status icons under 

the name of the appliance will be updated ( on the left indicating that the appliance is off and 

on the right indicating that the appliance is in the Override Off mode). The appliance will remain 

off until you select another mode. Press another icon to stop the Override Off mode (in particular 

to return to Normal mode in which SWOpti will then control the appliance). 

 

Press the icon to launch an Override On. The status icons under the name of the appliance will 

be updated ( on the left indicating that the appliance is on and on the right 

indicating that the appliance is in Override On mode). The appliance will remain on until you select 

another mode. Press another icon to stop the Override On mode (in particular to return to 

Normal mode in which SWOpti will then control the appliance).  Note that if you place an appliance in 

Override On mode, that does not mean that the appliance will necessarily consume power (a hot water 

tank will not consume any electricity if the water is already hot). 

 

If you want to turn off an appliance for a certain length of time, configure an Immediate Timed Override 

Off. Each press on  - 1  will increase the override off time by one minute.  - 5  increases the override off 

time by 5 minutes in one go, and   - 30  30 minutes.  As soon as you press one of these buttons, the 

appliance is turned off (if it was turned on) and the status icons under the name of the appliance will 

be updated ( on the left indicating that the appliance is off and on the right indicating 

that the appliance is in Immediate Timed Override Off mode).  In a few seconds, the number of override 

off minutes that you have configured will be displayed in the righthand part of the screen, prefixed with 

"-" indicating that this is a Timed Override Off.  For example, "-10 min" means that the appliance will 

be off for 10 minutes. In one minute, "-9 min" will be displayed and so on until "0 min" is reached.  If 

you have gone too far in the number of override off minutes, do not use the + 1   + 5  + 30  buttons to 
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correct the number of minutes. These buttons are reserved for configuring an Immediate Timed 

Override On.  To correct the number of minutes, press to return to Normal mode, which will 

cancel the Immediate Timed Override Off and will reset the timer to 0 minutes.  Then use the  - 1   - 5     

- 30  buttons. 

 

 If you want to turn on an appliance for a certain length of time, configure an Immediate Timed Override 

On. Each press on   + 1  will increase the override on time by one minute.  + 5  increases the override 

on time by 5 minutes in one go, and   + 30  30 minutes. As soon as you press one of these buttons, the 

appliance is turned on (if it was turned off) and the status icons under the name of the appliance will 

be updated ( on the left indicating that the appliance is on and on the right indicating 

that the appliance is in Immediate Timed Override Off mode).  In a few seconds, the number of 

override on minutes that you have configured will be displayed in the righthand part of the screen. For 

example "+10 min" means that the appliance will be on for 10 minutes. In one minute, "9 min" will be 

displayed and so on until "0 min" is reached.  If you have gone too far in the number of override on 

minutes, do not use the  - 1   - 5   - 30  buttons to correct the number of minutes. These buttons are 

reserved for configuring an Immediate Timed Override Off.  To correct the number of 

minutes, press to return to Normal mode, which will cancel the Immediate Timed Override On and will 

on 

reset the timer to 0 minutes.  Then use the  + 1   + 5    + 30  buttons. 

 

When the minutes of an Immediate Timed Override Off or an Immediate Timed Override On have 

elapsed, SWOpti switches the appliance back to Normal mode.  So SWOpti will then decide whether to 

turn the appliance on or off. You may prefer that an appliance be turned on when it comes out of an 

Immediate Timed Override Off, and that it be turned off when it comes out of an Immediate Timed 

Override On.  Others prefer that an appliance remain off when coming out of an Immediate Timed 

Override Off and that it remain on when coming out of an Immediate Timed Override On.  You can 

indicate your preference by using the icon located between the "minute" buttons. When the 

icon is displayed, SWOpti is in "Reverse Override End " mode. The yellow and black arrows indicate a 

switching between "on" and "off". When this icon is displayed, at the end of a Timed Override Off, the 

appliance will be turned on, and at the end of a Timed Override On, it will be turned off.  The state of 

the appliance will therefore be "Reversed" at the end of the override.  Press this icon to select the other 

preference, "Normal Override End ". When the icon is displayed, there will not be any 

"reversal" of the state at the end of the override. An appliance coming out of an Immediate Timed 

Override Off will remain off and an appliance that was in Timed Override On will remain on.  This 
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"Reverse" or ""Normal" preference is a global preference; it cannot be set differently for several 

appliances with overrides at the same time. That is to say, if you have several appliances with overrides 

in effect at the same time, it is the state of this preference that happens to be in effect at the end of 

the override of an appliance that will be applied.  Keep in mind however that, in any case, SWOpti 

switches the device to Normal mode at the end of the override, so your preference for "Reverse" or 

"Normal" will be applied for a relatively short period of time because, a few minutes later, it will be 

SWOpti (now in Normal mode for this appliance) that will be deciding whether to turn the device 

on/off. 

 

As mentioned above, the icon is used to switch to Normal mode. Any other mode in effect 

(Override Off, Override On, Timed Override Off and Timed Override On …) will be cancelled and if a 

Timed Override Off or Timed Override On was in progress, the minute counter will be reset to zero. 

 

There is an interesting variant of the Immediate Timed Override On and Immediate Timed Override Off 

modes: Deferred Timed Override On and Deferred Timed Override Off modes.  In the Immediate modes, 

the minutes start to count down immediately. With the Deferred modes, you can indicate the time of 

day at which the Deferred Timed Override On or Deferred Timed Override Off is to start. This could be 

useful for example to configure your hot water tank to turn on at 5am for 1 hour so that you can have 

hot water at 6am for a person leaving for work (and this can be restricted to only certain days of the 

week). To configure this mode, make sure the appliance in question is indeed selected, then, above the 

bar with the days of the week, press   -   to increase the time during which the appliance will be off, 

and   +  to increase the time during which the appliance will be on. Each press of the button increases 

the time by 15 minutes. Here, if you have gone too far in programming the minutes, you can use the 

other button to adjust the delay. The currently selected number of minutes will be indicated 

immediately above the   - - > 0 < - -   button.  You indicate the time of day to begin the override using 

the drop-down lists above the display of the minutes. To cancel this mode, press  - - > 0 < - -   to set the 

minutes to zero. You can indicate which days of the week this programming is to be executed by using 

the buttons in the bar with the days of the week. "MON" (in capital letters) indicates that the override 

will be executed on Mondays, and "mon" in small letters indicates that it will not be executed on 

Mondays.  Press the button of the day to switch between capital/small letters. As this is deferred 

programming, there is no icon to indicate this mode.  Indeed, the appliance will remain in Normal mode 

or any other mode until the time of day has arrived to start the Deferred Timed Override On or Deferred 

Timed Override Off.  When the time has arrived, the icon that indicates the mode of the appliance in 

the righthand part of the screen (and in the lefthand part of the screen if this appliance is selected) will 

be: 
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to indicate a Deferred Timed Override Off. The icon is black to indicate that this is an Override 

Off, the stopwatch reminds you that this Override Off is Timed, and the clock indicates that 

this is an override off that begins at a price time (Deferred). 

 

 to indicate a Deferred Timed Override On. The icon is yellow to indicate that this is an Override 

On, the stopwatch reminds you that this Override On is Timed, and the clock indicates that 

this is an override on that begins at a precise time (Deferred). 

 

A recently added feature is the Guaranteed Operating Time mode. This mode guarantees that an 

appliance will run for a certain amount of time (a pool filter pump that must run five hours every day, 

for example). To set up this mode, make sure that the appliance is selected, then, above the day bar, 

press  +   to increase the number of minutes that the appliance must operate. Each press of the button 

increases the time by 15 minutes. If you have gone too far, use the other button  -   to adjust the time. 

The number of minutes for the operating time is indicated immediately above the  - - > 0 < - -  button.  

As it is not possible to schedule zero minutes or a negative number of minutes for the Guaranteed 

Operating Time mode, this mode will be deactivated automatically if you set the minutes to zero or set 

a negative number.  Note that the scheduled start time displayed below the name of the appliance is 

of no importance in the Guaranteed Operating Time mode and therefore will not be displayed when 

the Guaranteed Operating Time mode is active. This mode will be active for the days of the week 

displayed in capital letters. To activate the Guaranteed Operating Time mode, press the icon above the 

number of minutes. indicates that this mode is activated and that it is deactivated. 

This icon is in the form of a stopwatch, reminding you that this is a timed mode, but 

the small black (off) and yellow (on) icons indicate that this is a mode with intermittent operation. 

Indeed, at sunrise, SWOpti will turn on the appliance and will indicate the number of minutes remaining 

that the appliance must operate on the right-hand part of the screen. SWOpti will control the appliance 

as if it were in Normal mode (it will be turned on if you have free electricity and turned off if you don't). 

BUT the remaining minutes will decrease only if the appliance is actually operating. As such, your 

appliance will get its operating time in, but only at the moments of the day when it is free. Two 

outcomes are possible with this mode. Either there was enough sun and the appliance was able to get 

its five hours in. In this case, SWOpti will execute one of the three options that you can configure: 

• Turn off the appliance, but switch to Normal mode, which will allow the appliance to continue 

operating if you have enough solar power. With the appliance selected, type PGUAR=0 in the 

command field and click on "ABC → XYZ". 
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• Set up an Immediate Timed Override Off for the appliance for a certain number of minutes. 

With the appliance selected, type PGUAR=n (where n is the number of minutes of stoppage 

desired) in the command field and click on "ABC → XYZ". This will turn off the appliance) for 

the designated number of minutes, which could allow other appliances to benefit from your 

solar production. This is the default option with an Immediate Timed Override Off of 60 

minutes. 

• Turn off the appliance, and leave it off until sunrise the following day. With the appliance 

selected, type PGUAR=999 in the command field and click on "ABC → XYZ". 

 

Or, at sunset, the appliance was able to function only for three hours for example. In this case, SWOpti 

will set up an Immediate Timed Override On for the two missing hours. If you have a contract that 

benefits from a lower rate at certain times of the day, SWOpti will of course initiate this Immediate 

Timed Override On when the lower rate is in effect. Note that the Deferred Timed Override On and 

Deferred Timed Override Off modes are not compatible with the Guaranteed Operating Time mode. If 

a Deferred Timed Override On or Deferred Timed Override Off is scheduled and you set up a Guaranteed 

Operating Time, the Deferred Timed Override On mode or Deferred Timed Override Off mode will be 

replaced with the Guaranteed Operating Time mode. 

 

Special features in the Guaranteed Operating Time mode 

If Guaranteed Operating Time mode is active and you change the appliance's mode (you switch mode 

to Normal, you launch an Immediate Timed Override On, etc.), Guaranteed Operating Time mode is 

obviously cancelled. There will be no evaluation at sunset as to whether or not the appliance has 

completed its guaranteed operating time since this mode is no longer active.  This mode will only come 

into effect again the following morning at sunrise. If this mode is interrupted during the day, there is 

however a way to start it up again. When the Guaranteed Operating Time mode is programmed for the 

appliance but this mode is not currently active for some reason, there will be a small icon with an "X" 

displayed to the right of the icon. Click this small icon to restart Guaranteed Operating Time 

mode. It will start with the number of minutes initially scheduled. 

 

The other special feature in Guaranteed Operating Time mode concerns households that have a 

peak/off-peak rate scheme. Normally, in this mode, SWOpti will operate your appliance only when it 

can be done so free of charge with the solar production available. At sunset, if the appliance was not 

able to operate for the number of scheduled minutes, SWOpti launches the Timed Override On mode 

for the number of minutes to catch up. If you have an off-peak plan, this catching up is delayed until 

the beginning of the next off-peak rate period (generally at night). More and more frequently, there 
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are now off-peak rate periods during the day. If you want, you can tell SWOpti to force an appliance 

that is in Guaranteed Operating Time mode to operate during an off-peak rate period during the day, 

even if this means that you may consume electricity from the grid. For each appliance, to the left of 

the icon that indicates the status of the Guaranteed Operating Time mode, there is a 

small icon that tells SWOpti to operate the appliance only when solar production allows (the normal 

operation in Guaranteed Operating Time mode), or to force the appliance to operate during an off-

peak rate period.  Click on these small icons to switch between these two possibilities. 

 

SACRIFICABLE/PRIVILEGED APPLIANCES 

Let's say you have a priority 1 appliance (a water heater that requires 3000 watts) and a priority 5 pool 

filtration pump, which requires 800 watts. The other appliances with priorities from 2 to 4 each require 

3000 watts to operate. In the morning, when your production reaches 800 watts, SWOpti will turn on 

the pool pump. Even if there are 4 other appliances with a higher priority than the pump, SWOpti 

cannot turn them on because there is not enough production. But when your production reaches 3500 

watts, for example, SWOpti still cannot turn on your water heater because, of these 3500 watts, 800 

watts are still being used by the pump, and therefore only 2700 watts remain, insufficient to turn on 

the water heater. But if we turned off the pump, 800 watts would become available, and the water 

heater could be turned on. In this scenario, the pump is a "sacrificable" device and the water heater is 

a "privileged" device. On the SWOpti control screen, to the right of the priority change icon, you have 

an icon that indicates whether the device is a sacrificial device , a preferred device , or 

neither (normal). Click on this icon to switch between these possibilities and designate the 

appliance as sacrificable, privileged or normal. SWOpti will "sacrifice" and "privilege" appliances only 

if their general mode is Normal or Guaranteed Operating Time. 

 

RENAMING AN APPLIANCE 

Under the green bar that indicates the name of the currently selected appliance, there is a bar with 

four sections. You can rename the currently selected device on the left side of this section; click 

"ABC --> XYZ" to confirm. 

 

MANAGING APPLIANCES WITH A MINIMUM OPERATING TIME 

Some appliances, such as a filtration pump for a swimming pool, require priming before filtration can 

actually begin. It is recommended that this type of appliance NOT be turned off during this priming 

period.  You can use the field normally used to rename an appliance to set the minimum operating 

time. To do this, make sure the device in question is the currently selected appliance, and type 

MINON=7 (in minutes, without spaces, think "MINimum ON") in the field and then click "ABC --> XYZ".   
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To the right you will see "֎  = 0 / 7 min" displayed. This means that this device will remain on for a 

minimum of 7 minutes each time that it is turned on.  If the appliance is indeed turned on, you will see 

"֎  = 1 / 7 min" and one minute later "֎  = 2 / 7 min". After the 7 minutes have elapsed, "֎  = 0 / 7 

min" will be displayed again. 

 

APPLIANCE PRIORITY MANAGEMENT 

In the middle of this section, you will find a button and a number that indicates the level of 

priority for the currently selected appliance. If the currently-selected appliance has priority 14, click 

the icon and the appliance will now have priority 13 (the appliance that had priority 13 will now have 

priority 14). After a few moments, the appliance's new order of priority (13) will be displayed. It is not 

possible to directly lower an appliance's priority.  To lower the priority of an appliance, select the 

appliance on the Control screen with the immediately lower priority, then use the button to increase 

the priority of this appliance (to lower the priority of appliance 13, you must increase the priority of 

appliance 14). You cannot increase the priority for appliances beyond the number that you actually 

have. Obviously, you cannot increase the priority of the appliance that already has top priority. 

 

 

APPLIANCE WATTS MANAGEMENT 

You can use the right part of this section to manage how many watts your appliances need. As you 

know, SWOpti analyses your production and your consumption. If you are sending electricity to the 

grid, SWOpti will try to turn on appliances so as to use this free electricity rather than lose it. In order 

to know whether it can turn on an appliance without causing a need to consume electricity from the 

grid, SWOpti needs to know how many watts your appliances need to operate. This value can be 

modified on the main screen by indicating a new value in the input box and confirming with the [Enter] 

key. The value cannot be negative or higher than 12,000 watts. 

 

The main control screen displays information concerning appliances 1 to 18. If your SWOpti 

controls/monitors more than 18 appliances, you can display appliances 19 to 36 by clicking at the 

bottom of the screen on the right on the arrow. 
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FOR EDF TEMPO CONTRACT HOLDERS 

 

EDF markets an electricity contract where the rates are based on the colour of the day (blue is the most 

economical, then white, and finally red, the most expensive). A " Tempo day" begins and ends at 6am.  

Each day is divided into a high-rate period (from 6am to 10pm) and a low-rate period (10pm to 6am).  

That results in 6 rates, with the colour red in the high-rate period being the most expensive (0.7562 

euros per kWh at the time this document was written!). 

 

SWOpti can handle these red days. To activate this mode, press the icon at the bottom of the lefthand 

side of the screen. Each press activates or deactivates this mode: 

 

Tempo mode activated. SWOpti will monitor the red days and will implement its 

programme automatically to help you save money when a red day is in progress. 

 

Tempo mode deactivated. SWOpti will still monitor the red days and will display the 

information, but will not implement its programme when a red day is in progress. 

 

 

Let's suppose that today is Wednesday and that tomorrow is a red day. At 10pm on Wednesday, SWOpti 

will set up an Override On for the hot water tank and the electric vehicle charger. If you have any 

electrical radiators, SWOpti will control them as usual, according to the temperature settings that you 

have set up.  SWOpti does not do anything in particular for radiators between 10pm and 6am; heating 

will be turned on and off as usual as needed.  However, at 6am, SWOpti will set up an Immediate Timed 

Override Off for the jot water tank, electric vehicle charger and all the electric radiators. The Immediate 

Timed Override Off will last 960 minutes (until 10pm Thursday).  You can see in the righthand 

section of the screen for appliances in "Tempo mode" and the number of minutes remaining in this 

mode.  At 10pm, SWOpti will return all the devices that are in Tempo mode to Normal mode. 

 

The icon for activating/deactivating Tempo mode is centred at the bottom of the lefthand part of the 

main screen. Just to the right of this icon, towards the top and to the left there is a small icon that 

indicates the current colour for the day and whether the high rate (HP) or low rate (HC) is in effect. 

Towards the top and to the right, an indication as to the colour for tomorrow will be displayed.  It will 

display the three colours (like a French flag) until about 12h05 pm, when the colour for the next day 
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becomes known.  If you do not have a Tempo contract with the EDF electricity supplier, these icons will 

not be displayed on the screen. 

IMPORTANT: By default, SWOpti considers your electric vehicle charger and your hot water tank as 

appliances that will be turned on the night before a red day (they will be in "preparation" mode). During 

the red day, these devices and, in addition, all your electric radiators will be turned off (they will be in 

"prohibition" mode). You can decide which appliances will be in "preparation" mode and those that 

will be in "prohibition" mode. To the left and right under the icon that indicates the Tempo mode, you 

will see small icons that indicate the mode concerning the currently selected appliance: 

 

the appliance will be in Normal mode the night before a red day. 

 the appliance will be in Override On mode the night before a red day. 

 

the appliance will be in Normal mode during the red day. 

 the appliance will be in Override Off mode during the red day. 

 

To switch the appliance between these modes, simply click on these icons. 
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DO YOU HAVE "PLUG-n-PLAY" PHOTOVOLTAIC PANELS? 

 

The production from your solar panels that you do not use is sent to the grid (unless you have a battery 

and it is not fully charged). Given that the grid may not be able to absorb all the excess electricity that 

is sent to it, your grid operator may impose an "injection limit", for example, you may not be allowed 

to inject more than 6000 watts. SWOpti allows you to have a relatively high number of plug-n-play solar 

panels, because it is constantly monitoring the amount of excess production that you are injecting to 

the grid. If you exceed the limit that is imposed upon you, SWOpti will automatically cut off as many 

plug-n-play panels as necessary so that you fall back down below your injection limit, thus allowing you 

to comply with this limit. You can tell SWOpti what your injection limit is by typing INJMAX=n in the 

command field (where n is the number of injected watts not to be exceeded) and then by clicking on 

"ABC → XYZ" to confirm. If you do not want to configure an injection limit, type INJMAX=99999. 

 

Note: On the main screen, in the details of your production, SWOpti will indicate that it has cut off a 

set of PnP panels because of the injection limit with an X : "PP1 = X".  
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CONFIGURATION SCREEN 

 

 

 

Click on at the bottom of the main screen to access the Configuration screen. 

 

LANGUAGE SELECTION 

The Configuration screen allows you to select the language in which the information bubble will be 

displayed (if your browser supports this feature) and in which the days of the week will be displayed 

on the main control screen and in the Temperature Settings screen.  The language currently in effect is 

displayed inside the balloon. Select a language from the drop-down list to switch SWOpti into that 

language. The modification takes effect almost immediately. 

 

PRODUCTION/CONSUMPTION HISTORY 

Click on the  icon to display the production/consumption history screen. 

 

CUSTOMER INFORMATION 

In the central part of this screen, if you need assistance, click on the blue technician with the gear. At 

the time this manual was written, it is the contact form on the www.swopti.fr website that will be 

displayed. In the future, a more appropriate page will be displayed. 

 

Under this section, you will find your customer number, information on your subscription (the date 

when your subscription expires or if it has expired), and a location to display any special messages 

coming from SWOpti if needed.  When you change the language, the information concerning your 

subscription will not be displayed in the new language until the following morning. 
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CONSUMPTION TOLERANCE MANAGEMENT 

As you know, SWOpti analyses your production and your consumption. If you are consuming (you are 

drawing electricity from the grid), SWOpti tries to turn off appliances to reduce or even eliminate this 

consumption.  When it analyses your consumption, SWOpti takes a consumption tolerance into 

account, which has a default value of 100 watts. If your production is for example 5000 watts, and your 

home is consuming 5075 watts, you are going to draw 75 watts from the grid. SWOpti will try to turn 

off appliances so as to not draw power from the grid. But as your consumption tolerance is set to 100 

watts, SWOpti will try to turn off appliances only if you are drawing more than 100 watts from the grid. 

The value of this consumption tolerance can be modified at the bottom of the Configuration screen by 

entering a new value in the input box and confirming with the [Enter] key. You cannot set a negative 

value or a value over 12,000 watts. 

 

INTERNAL AND EXTERNAL ACCESS A SWOPTI AND HOMESEER 

The right-hand portion of the screen provides information on how to access your SWOpti and 

HomeSeer from an internet browser using a PC, tablet, or mobile phone.  At the bottom of this section, 

you have the address for access to SWOpti and HomeSeer when you are connected to your local 

network (therefore in your home). Your SWOpti Box has a port number (the default is 85). If you 

configure your internet box to "forward" any incoming traffic coming into your box on port 85 to port 

85 of your SWOpti Box (supposing that you have already set up a static IP address for your SWOpti Box), 

you will then be able to access SWOpti and HomeSeer from outside your home. For this, you need to 

know your public IP address. Your public IP address is indicated at the top of this part of the screen.  

However, unless you have a static public IP address arrangement with your internet service provider, 

this address changes on a regular basis. You may very well note this address but once you are outside 

your home, your service provider could change this address. To overcome this problem, SWOpti 

provides you with a permanent link (therefore a link that never changes). This link displays the SWOpti 

and HomeSeer logos. By clicking on these logos, you can access your system when you are outside your 

home. Please note that for obvious security reasons, you will not be granted access to your system until 

you have entered your HomeSeer username and password.  
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SWOpti AND HEATING 

 

SWOpti can manage your electric radiators. SWOpti has a temperature settings table to the nearest 

half-hour and per day of the week for each radiator. The temperature setting is the temperature that 

you wish to have in the room in question.  The temperature setting tables are filled in with default 

values, but you can of course change these as you wish. On this screen, there is an icon in the lower 

lefthand corner. This icon indicates whether heating is on or off.   When heating is 

off, all radiators are in Override Off mode.  As such, they cannot be turned on. This is the case in the 

summer.  You can switch between Heating On and Heating Off simply by pressing this icon.  In the 

winter, you can use this button to temporarily turn off heating when you are on holiday away from your 

home. 

 

We have already mentioned that the righthand portion of the main control screen displays the watts 

that all controlled or monitored appliance are consuming.  You can therefore see the number of watts 

consumed by each radiator.  SWOpti displays the total number of watts being used for all radiators just 

to the right of the heating icon, under the icon. 

 

To manage the temperature settings, click on the icon and the following screen will be 

displayed: 

 

 

 

At the bottom left, there is an icon to show the state of the Heating (on or off).  You can switch between 

Heating On and Heating Off by clicking this icon. To the right of this icon, click on to return 

to the main control screen. 
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At first glance, this screen appears to be complicated, but it is actually very simple.  The upper lefthand 

part of the screen shows the list of radiators (or fans) and the current temperature in the rooms in 

question (to the left of the name of the source of heating) and, if your system so allows, the humidity 

(to the right of the name of the source of heating). Click on the name of one of these radiators to select 

it. This will update the righthand part of the screen with the data pertaining to the radiator that you 

have selected.  On the sample screen shown here, the Rad Parents radiator is selected (we can see its 

name displayed at the top of the righthand side of the screen), and we can see the temperature settings 

in the table configured for this radiator, per day and half-hour by half-hour.  We can see for example 

that the desired temperature between 5am and 5h30am on Mondays for this room is 16°, and that the 

desired temperature between 5h30am and 6am on Mondays is 17°. 

 

It is very easy to change the temperature settings that SWOpti must use to manage the radiators. Once 

you have selected the radiator in question, select the day (or days) for your modification in the drop-

down list (the top of the righthand part of the screen will be update to reflect your selection). Then, in 

the temperature drop-down list between 2° and 26°, select the temperature setting to be applied. It is 

possible to select such low temperatures so as to maintain a room just above freezing. Finally, from the 

other two drop-down lists, select the start time for your modification from the first list and the end 

time from the second list.  Check that the top part of the righthand portion of the screen is correctly 

displaying the selections that you have just made, then click on to confirm your modifications. 

Wait a few seconds and then check that your modifications have been taken into account in the 

updated table that will be displayed. 

 

NOTE: When you are working with a device that cools, such as a cooling fan, the temperature setting 

is the temperature that you do not want to exceed in the room.  If you configure a temperature setting 

of 23° for a cooling fan, SWOpti will turn on the fan when the temperature reaches 23°. 

 

SWOpti updates the setpoint temperatures every 30 minutes. If the current temperature setpoint is 

19° and the time is 15h12, and you set a new setpoint of 20° for 15h00 to 17h00, the new setpoint 

temperature of 20° will not take effect until 15h30, because the current setpoint of 19° was updated at 

15h00 for the period of 15h00 to 15h29. 
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THE DELTA TEMPERATURE AND "CATCH-UP" TIME 

 

SWOpti decides to turn on or off a radiator according to the current temperature in the room and the 

temperature setting (desired temperature) for the room.  But at the same time, SWOpti is trying to 

reduce or avoid drawing power from the grid. This means that SWOpti could turn on a radiator (because 

it is 18° in a room where the temperature setting is 19°), but just a few minutes later, SWOpti detects 

that we are drawing power from the grid.  According to the watts consumed and the order of priority 

for the appliances, SWOpti may very well turn off the radiator that it turned on just a few minutes ago.  

As time passes, this could result in that the temperature in the room continues to drop, until it becomes 

uncomfortably cold. To overcome this problem, SWOpti benefits from the notion of "delta 

temperature" and "catch-up" time.  In the sample screen, we can see, to right of the icon, 

that the delta temperature for the selected radiator is 3° and that the catch-up time is 45 minutes.  If 

the temperature setting at a given time for the room is 19°, and the temperature in the room drops to 

16° (a difference of 3°), we have reached the delta temperature. SWOpti will automatically programme 

an Immediate Timed Override On for this radiator so that is stays on in order to heat the room.  The 

duration of this Immediate Timed Override On is the "catch-up" time (45 minutes in the example). To 

modify these two settings, select a delta temperature between 2 and 5° from the drop-down list on 

the left and the catch-up time with the list on the right. Your selections will be displayed above the 

drop-down lists. The modifications concerning the delta temperature and catch-up time will be applied 

only to the selected radiator. 

 

Use the button to return to the main control screen. 
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PRODUCTION/CONSUMPTION HISTORY 

 

On the Configuration screen, click on the  icon to display the production/consumption history. 

 

This icon displays information concerning the consumption of your appliances:  

 

 

This icon displays information for your system in general, in particular your self-

consumption and your self-sufficiency: 

 

 
View for each day  

of a month 

 
View for each month  

of a year 

 
View for an 
entire year 

Displays the data for the 
previous period 

 
Download the 
data 

Displays the data for the 
following period 
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ADVICE TO KEEP YOUR SWOpti IN GOOD WORKING ORDER 

 

SWOpti does not require any particular maintenance, but like any other software that is running on a 

computer, there are a few basic rules that you should comply with. 

 

1. THE MEASUREMENTS AND STATUS INFORMATION SEEM TO BE INCORRECT 

SWOpti uses a Zigbee controller to communicate with the clamps and micromodules. If there is an issue 

with Zigbee, SWOpti cannot operate correctly. Sometimes, after a long period of time with no incidents, 

a problem arises because the cache memory is saturated or there are too many "temporary" files on 

the computer. PCs need to be shut down and turned back on to "clean" the memory. HomeSeer uses 

a Plugin to communicate with the Zigbee controller, and the controller itself is managed by a driver 

which has to be active.  To "reset" the Zigbee plugin: Go to the "Plugins → Manage" menu of your 

HomeSeer and slide the blue button towards the left to deactivate the Plugin: 

 

Wait for the following screen to be displayed, then slide the button back to the right: 

 

After a minute or two, you should see the screen with "OKAY" in green, as in the first image 

hereinabove). If the following screen is showing: 

 

this means that the plugin has been reset but not the driver. Click on MORE → Zigbee2MQTT Back-End, 

then click on START to reset the driver. After a minute or two, you should see the message 

"Zigbee2MQTT is running" above the START button. Otherwise, do another START until you obtain the 

"Zigbee2MQTT is running" message. 
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2. POWER OUTAGES 

If you are planning to work on your electrical network and you need to cut off the power, remember 

to shut down HomeSeer and then shut down the SWOpti Box. Computers do not like to be shut off 

abruptly when it can be avoided. To shut down HomeSeer, connect to your SWOpti Box with Remote 

Ripple, and shut down the HomeSeer application with the red X: 

 

Then click on "OK" to confirm the shutdown: 

 

Then use the normal Windows functions to shut down the 

PC.  

 

 

3. BACKUPS 

Your SWOpti performs a backup all by itself at 3:01 am on Mondays, Wednesdays, Fridays and Sundays. 

The 10 most recent backups are kept (when the 11th backup is done, the oldest backup will be deleted). 

Backups are stored in the \html\backups directory in your HomeSeer directory on the SWOpti Box. Use 

the procedure below to modify the time for the backup, the number of backups to be retained, the 

days of the week and, very important, the destination directory for the backup. Indeed, it is better to 

not store the backups on the SWOpti Box itself but on another computer, if you have a network drive 

or USB key for example. Here is HomeSeer's procedure for managing backups: 

1. In HomeSeer, go to Tools > Backup/Restore and click EDIT at thje bottom right in order to 
enable modifications. 

2. Save To should be left on "default" unless you want to use a network drive or USB key. If this 
is the case, enter the complete path to the destination folder. Example: \\MY-
SERVER\HomeSeerBackups. 

3. Max Backups determines how many ba ckups are kept. 
4. Tick Auto Local Backup. 
5. Time determines when the backup will start. We recommend a time late at night or early in 

the morning when in principle fewer HomeSeer events are running. 
6. In the Days section, tick the days of the week for the backup. If you do not generally make 

many changes to your system, one backup a week is probably enough. 
7. Click Save, and your automatic backup schedule will be activated! 
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4. WHEN SWOpti SEEMS TO NO LONGER BE COMMUNICATING WITH APPLIANCES 

Your SWOpti mini PC has to be able to run without interruption. By default, the PC is configured to turn 

off the screen, put the hard drive on standby, etc. if there is no activity with the keyboard, mouse, etc. 

If Windows deactivates components, this can cause malfunctions for HomeSeer and SWOpti. When it 

is manufactured, these "standby" or "sleep" functions are deactivated in your SWOpti Box so that 

SWOpti can operate correctly. 

 

After a Windows update, these features are sometimes automatically reactivated. They have to be 

deactivated again. In particular, your Zigbee controller operates on a USB port; the USB ports must 

never go into standby or sleep mode. 

 

Check that standby/sleep modes are deactivated by going to Control Panel* → System → Power 

Options. In the "Standby" section, the parameters should be set to "Never". Then click "Additional 

power settings", then "Modify the computer's conditions for standby" and finally "Modify advanced 

power settings ".  Expand the options under "Hard drive " and set them to "Never". In "Standby" set 

the parameters to "Never" or "Deactivated" for the first 3 options ("Standby after", "Allow hybrid 

standby" and "Go to prolonged standby after"). In "USB settings" then "USB selective suspension 

setting", set the two options to " Deactivated". Don't forget to click OK. 

 

* The names of these menus and options were translated from French. They may be worded differently 

on your PC. 

 

5. HOMESEER'S "LOG" IS FILLING UP FAST 

When an "event" is triggered in the system, HomeSeer logs this by writing a line to a log file. You can 

view this log file via the menu Tools → Log. Some events are triggered every five seconds, which causes 

the log file to grow in size very quickly. Fortunately, there is an option that can be used to tell HomeSeer 

not to write these lines to the log for such and such an event.  Unfortunately, after an update (new 

version of SWOpti…) has been made to the system, this option is reset to its default value, which is to 

write these lines. To "alleviate" your system, you must reactivate this option manually. To do this, go to 

the menu Events and click JJF Services. In the list of events, click JJF-PowerCalc then Advanced Options. 

Tick the box Do not log if it is not ticked and click Save. Click JJF Services to display the list of events 

again, then do the same for events JJF-SoH, JJF-Power, JJF-OverrideMaint, JJF-TempControl, Refresh, 

JJF-ScrUpd and JJF-ZB-ZW-Check. 


